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Welcome 

Thank you for purchasing Qsep1-Lite capillary electrophoresis system. Now you can 

experience this high-performance, fully-automated and easy-to-use system. 

Copyright and Trademarks 

Copyright ©BiOptic Inc.  

All rights reserved. Reproduction, adaptation, or translation of this manual is 

prohibited without prior written permission of BiOptic Inc., except as allowed under 

the copyright laws. 

Qsep™ and Q-Analyzer™ are registered trademarks of BiOptic Inc. 

Microsoft Windows is registered trademarks of Microsoft Corporation. 

Product and company names listed are trademarks or trade names of their respective 

companies. 

 

Symbols of Qsep1-Lite 

Symbol Description 

 

 

CE mark for European Conformity.  

 

 

FCC mark of the United States Federal Communications Commission. 
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Limitation of Liability 

 
Qsep™ Bio-Fragment Analyzer, Q-Analyzer™ software, and all related reagents are 

designed for the use of electrophoresis analysis in general bio-chemistry laboratory. If 

you use it for profit, diagnosis, or other non-research purposes experiments, the 

company is not responsible for the accuracy and reliability of the result and the safety 

of operation. 

 

BEFORE ATTEMPTING TO OPERATE THE INSTRUMENT, READ ALL PRODUCT 

MANUALS AND FOLLOW THE INSTRUCTIONS. 

 

BiOptic Inc. assumes no liability whatsoever for any personal injury, property damage, 

or other loss resulting from not complying or familiar with the manuals, or improper 

operation of the devices. 

 

Applications of Qsep1-Lite 

Genetic Profile Screening 

Amplified Fragment Length Polymorphisms 

Bacterial/Viral Genotyping and Identification 

PCR Product Analysis 

Rapid Analysis of Genomic DNA Samples 

Low Concentration of Sample Detection 

Total RNA Analysis 

Packing List of Qsep1-Lite 

Each Qsep1-Lite™ instrument package comes with the following: 

Qsep1-Lite™ CE instrument 

Qsep1-Lite™ Standard and High Resolution Cartridge Kit (C105200-L) 

Qsep1-Lite™ Power Cord with Adapter 

Ethernet Cable 

Software Key (Basic edition) 
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Sample Trays (12 and 8 wells) 

Qairbox Portable DC Air Pump 

Qairbox Power Cord with Adapter 

Installation Disc including Qsep1-Lite™ Operation Manual 

*Note: The Software key contains 8GB storage space, Q-Analyzer™ for Qsep1-Lite and 

Qsep™ Series Operation Manual, including Hardware version and Software version.  

  



8 
 

Cautions 

Qsep™ Series are capillary electrophoresis instruments driven by high voltage.  

Carefully read and thoroughly comply with the following instructions to maintain the 

integrity of the equipment, the reliability of results, and the safety of operation.  

Keep Qsep™ Series away from other electronic device and voltage sources. 

 

1. Only the components and consumables provided by BiOptic Inc. are 

suggested to use. 

2. DO NOT perform the following actions: 

• Disassemble Qsep™ Series instrument and its associated parts 

• Bumps or jolts to Qsep™ Series  

• Move the instrument or remove any connected external equipment, 

such as computers and air pumps, while Qsep™ Series are in action 

• Open the sample door or cartridge door while Qsep™ Series are in 

action 

• Remove the cartridge while Qsep™ Series are in action 

• Power off Qsep™ Series before confirming Qsep™ Series are not in 

action 

3. Store the cartridge upright; do not lay the cartridge on a table horizontally or 

place it upside down. 

4. Store the cartridge in the calm-shell container (Cartridge needs to be stored 

in a proper environment as the instructions of cartridge unpacking guide to 

maintain its lifetime and quality). 

5. Ensure the cartridge is unlatched and take out from the instrument before 

shutting down or disconnecting Qsep™ Series. Failure to do so will cause 

dryness of the gel at the cartridge tip, which will damage the cartridge. 

6. Before operating Qsep™ Series, ensure the sample tray is placed properly.  

7. Ensure that the test sample, marker, cartridge, and buffer have been 

removed from the instrument before transporting or shipping.  

8. Ensure that the main power of the instrument has been shut down and all 

the test materials have been removed before cleaning Qsep™ Series . 

9. User can also use N2 gas as an air source to insure the air quality and prevent 

damages to the devices caused by dirty air. 

10. Make sure to press the plastic connection ring before pulling the air tube out 

from the back of the instrument. 

11. Release the condensation water in the external air pump periodically and 
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check water level before each use to avoid the mist damage the devices of 

Qsep™ Series. 

12. To cut off the power please disconnect the power plug. 

13. Please use the MAIN power cord within adequate rating.  

14. The conditions of transportation and storage: Temperature -30 to +60°C 

Humidity 20 to 80% RH, non-condensing. 

 

*Note: Strongly suggest performing this step whenever you start to operate Qsep™ 

Series . 

 

Warning: Qsep™ Series are high-voltage Single-channel electrophoresis system. 

Please follow the operation manual and laboratory safety guidelines for system 

operation. Do not remove covers. For operation and safety questions, please contact 

BiOptic Inc. at the official website or with your local BiOptic representatives. 
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1. System Overview 

Qsep1-Lite™ is a fully-automated CE system developed by BiOptic Inc., which uses pen-

shaped disposable gel-cartridge to improve efficiency. Time-consuming manual 

procedures such as gel preparation, sample loading, and capillary changing are no 

longer required. Further, the information will be obtained easily with the fully- 

automated. Qsep1-Lite™ is designed to accommodate 1 to 8 samples. 

 

Qsep1-Lite™ ’s compact design helps you to set up and operate the instrument 

intuitively. The disposable gel-cartridge with integrated pre-programmed test method 

makes capillary electrophoresis experiments no longer a painful procedure that 

requires well-trained operators. No more worries about operation and human errors 

caused by different operators which affect the accuracy and reproducibility of the 

results. 

 

The following sections will describe the product overview, the functions of Qsep1-Lite™ 

and the disposable gel-cartridge. Please read through these sections and get ready to 

be amazed at the power of Qsep1-Lite™. 

 

Caution: The operator of Qsep1-Lite is advised that if the equipment is operated in a 

manner not specified in this manual, the protection provided by the equipment may be 

impaired. 
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1.1 Pre-Programmed Method and Cartridge 

Qsep1-Lite is designed to work with the special-designed cartridges provided by BiOptic 

Inc.. The modularization design of cartridges makes the time-consuming gel 

preparation no longer be required. In order to provide more intuitive operation 

workflow, each cartridge only have one suitable method (Figure 1-1). User can follow 

the instruction from software to select sample position (Figure 1-2) and adjust 

separation time (optional) (Figure 1-3) to analyze their samples. The alignment marker 

and size marker also be included in cartridge kit, user no need to think about how to 

select proper markers.  

 

 

Figure 1-1 One Method  
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Figure 1-2 Select sample position 

 

  

Figure 1-3 Adjust separation time and Run 
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1.2 System Requirements  

  Minimum Recommended 

OS Windows 10 32 bit Windows 10 64 bit 

CPU Intel Core i5 Intel Core i7 

RAM 8G RAM 16G RAM 

HDD 500 GB 1 TB 

PORT RJ45 x 1 RJ45 x 2 

Screen Resolution 1280 x 800 1920 x 1080 
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2. Q-Analyzer Installation Instruction 

A suitable operating environment is essential to ensuring the best performance of Qsep1-

Lite ™. 

 

2.1 Software Installation 

The software “Q-Analyzer for Qsep1-Lite” is specially designed to operate Qsep1-Lite ™. 

The software key will be found in the package. Click “Q-Analyzer_for_Qsep1_Lite-

Setup.exe” to begin the installation. 

 

*Note: Please close all the other applications before installing Q-Analyzer for Qsep1-Lite. 

In addition, DO NOT connect Qsep1-Lite ™ to the computer while installing Q-Analyzer 

for Qsep1-Lite. 

 

The installation steps are as follow: 

Step 1. Click Q-Analyzer for Qsep1-Lite-Setup.exe to start to install software 

   

 

Step 2. Specify the default data archive folder 

 

 

Step 3. Select the program destination 
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Step 4. Create a desktop icon and select the driver you need to install 

 

 

 

Step 5. Verify the settings of the installation and click Install to start the installation 
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Step 6. Q-Analyzer for Qsep1-Lite installation is in progress 

 

 
 

Step 7. The installation is completed and Q-Analyzer for Qsep1-Lite is ready to be 

launched 
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After launching Q-Analyzer for Qsep1-Lite, the Main Window appears on the screen 

and automatically connects with the Qsep1-Lite instrument. The instrument page is used 

to communicate with the device (Figure 2-1). 

The software will create a default project named according to the date automatically.

 

Figure 2-1 Software overview 
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2.2 Software Mode 

Q-Analyzer/Q-Editor/Q-Viewer are integrated into the installed software. 

Q-Analyzer for Qsep1-Lite Setup has combined with these three programs, so there is no 

need to install them separately. Please double-click the icon and follow the on-screen 

instruction to install it. 

When double clicking Q-Analyzer for Qsep1-Lite icon, the software will automatically 

detect the status and launch the respective program according to the condition below. 

(Q-Analyzer, Q-Editor, or Q-Viewer) 

 

Table 1. Software Authentication 

Condition 

Mode 

Software Key 

(Advance) 

detected 

Software key 

(Basic) detected 

Instrument 

connected   

Q-Editor License None 

Password      

Q-Analyzer 

(Advance) 

     

Q-Analyzer (Basic)      

Q-Editor      

Q-Viewer      

 

Table 2. Software Function Level 

Condition 

Mode 

Instrument Control 

(advance) 

Instrument Control Post Data 

Analysis 

Read Note 

Q-Analyzer (Advance)     Create Method 

Q-Analyzer (Basic)      

Q-Editor     License is bound 

to the PC 

Q-Viewer      

 

Without connecting with Qsep1-Lite or the software key, user can click To View to start 

the Q-Viewer, after launching Q-Analyzer for Qsep1-Lite. The Q-Viewer is only used to 

display the analysis result. 
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2.2.1 USB Software Key 

⚫ Activation Software Key 

A software key (Figure 2-2) is required, if the user want to launch the software in Q-

Analyzer mode without connect with Qsep1-Lite. The software key must be activated 

first before its initial usage. Insert the software key into a computer equipped with 

available USB port before launching Q-Analyzer for Qsep1-Lite. 

 
Figure 2-2 Software Key 

The system will automatically lead you to the activation page while starting Q-

Analyzer for Qsep1-Lite (Figure 2-3). Enter your Company Name, User ID, and 

Password. After confirming the password, you will be directed to the Login page 

(Figure 2-4). 

 

  

Figure 2-3 Software key activation 

 

*Note: Password comprises 8 characters in length contained characters and/or 

numbers and is case-sensitive. 

If the user wants to change the password of the software key, go to Change Password 

in Menu→Setting after the Q-Analyzer for Qsep1-Lite starts.  
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Figure 2-4 Login page  

 

⚫ Forget the password of the Software Key 

If the user forgets the password, do the following steps to reset the password. 

Step 1. Find Toolbox-License in the Microsoft Windows All Apps (All Programs)  

  

→ Insert the software key, then click Toolbox-License.  

→ If the software key is found, the Next button will be enabled. 

→ Click Next to enter the Toolbox window. 

 

 

Step 2. Click Unblock software key 
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The password of this software key will be reset to “00000000”. 

  
Figure 2-5 Unblocking the software key 
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2.2.2 Q-Editor License 

The Q-Editor mode helps the user to do the post analysis offline. 

Q-Editor requires a license registered in the computer. One software key provides five Q-

Editor licenses for different computers.  

 

To import the license, do the following: 

1. Launch Q-Analyzer for Qsep1-Lite without the instrument and software key 

connection. 

The message box of Input your license will appear on the screen. 

 
Click Copy to clipboard from Input your license message box. 

 

2. Find Toolbox-License in the Microsoft Windows All Apps (All Programs) 

 

Insert the software key, then click Toolbox-License. If the software key is found, click 

Next to enter the Toolbox window. 
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*Note: The number of Q-Editor license available and used will be listed on the table. 

 

3. Get Q-Editor license file 

I. Paste the activation code which copied from Input your License Toolbox (A). 

II. Enter your computer name in the Remark field (B). 

III. Click Get New License (C), then Get New License will be enabled. 

 

The new license will be generated in the table below. Please click Download to save 

the license as a file which can be used for launching Q-Editor later.  

 

 

 

*Note: If this computer has been registered under this software key, you can retrieve 

the license by clicking Show Registed License to download your license file again. 

  

4. Return to the Input your license window and click Import License to import the file 

you just downloaded. The Q-Editor is now activated for this computer. 
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3. Start to Operate Qsep1-Lite 

The software “Q-Analyzer for Qsep1-Lite” is specially designed to operate Qsep1-Lite. 

After installation, double click Q-Analyzer for Qsep1-Lite icon (Figure 3-1). To execute the 

software, the user needs to connect with Qsep1-Lite (instrument must be turned on first 

and the indicator light on Qsep1-Lite turns green) or plug the software key into an 

available USB port of the computer.  

 

  
Figure 3-1 Q-Analyzer for Qsep1-Lite icon 

 

There are two versions of the software key, Basic and Advanced. Each version has a 

different access level to software functions, and each software key is linked to its 

corresponding user account as well. Users with Advanced Software Key are able to use 

more functions, such as doing specific action for instrument maintenance. Basic 

Software Key is included in the instrument package. If you need more information 

about Advanced Software Key, please contact your distributor or visit BiOptic’s official 

website (https://www.bioptic.com.tw) for further assistance. 

 

  

https://www.bioptic.com.tw/
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3.1 Operation of Qsep1-Lite 

After launching Q-Analyzer for Qsep1-Lite, the Main Window appears on the screen. 

In this window, you can access the Instrument function which is used to communicate 

with the device (Figure 3-2). This section will only introduce the Main tab features and 

how to operate Qsep1-Lite (Figure 3-2 A). The other function tabs will be described later 

in the Section 4.4. 

 

 

Figure 3-2 Main window of the Instrument mode 
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3.1.1 Connection Assistance 

Please ensure Qsep1-Lite is connected to your computer using the ethernet cable. Turn 

ON the power of Qsep1-Lite, then click the icon to launch the software. The software will 

automatically connect with Qsep1-Lite. 

 

To establish the connection, click the Connect button on the Control Panel (Figure 3-3). 

When the Connect button changes to Disconnect and the displayed Qsep1-Lite picture 

turns into color form, which indicate the connection is established. 

  

Figure 3-3 Instrument connection 

  

The Purge Check message box will pop-up, after connected and before disconnected 

(Figure 3-4). Click Purge Check and follow the instructions to complete the process. 

“Purge Check” is used to ensure that air tube is not clogged before use and clean the 

gel which is accidentally sucked into the air tube after use. 

 

*Note: To avoid the permanent damage to the system, executing Purge Check function 

every time when the software requires is recommended. 

 

 

Figure 3-4 Purge Check message box 
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Using assigned sample tray (DNA cartridge: 12-well sample tray; RNA cartridge: 8-well 

sample tray). Prepare buffer, size marker mix, and sample mix then place all the tube at 

the corresponding position (Figure 3-5). Use 0.1 ml tube (C104252) to prepare sample 

mix when using 12-well sample tray and use 0.2 ml tube when using 8-well sample tray. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3-5 Sample/Buffer preparation 

 

*Note: Buffer and size marker mix must place in 0.2 ml tube 

*Note: When preparing sample mix in 0.1 ml tube, add 2 μl sample first. Then, add 8 μl 

alignment marker and gently pipetting to mix thoroughly. 

Position: Reagent Volume (ul) 

S well: separation buffer  200 

P well: distilled water  50 

C well: distilled water  200 

M, S1-S8 well: sample 20 

Position: Reagent Volume (ul) 

S well: separation buffer  200 

P well: distilled water  50 

C well: distilled water  200 

M well: size marker mix 20 

S1-S8 well: sample 10 

Sample mix Volume (ul) 

Sample 16  

Alignment marker 4  

Size marker mix Volume (ul) 

Size Marker 4  

Alignment marker 16  

Sample mix Volume (ul) 

Sample 2  

Alignment marker 8  

DNA RNA 
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Click Open Sample Door (Figure 3-6 A) to move the tray holder out. Put the sample 

tray into Qsep1-Lite. Click Park (Figure 3-6 B) to move the tray holder in. 

 

 

 

 

 

 

 

 

Figure 3-6 Open Sample Door and place the sample tray 

 

Open the cartridge door on the top of the instrument. Make sure the guiding groove of 

the cartridge is facing front (Figure 3-7). Then, insert the cartridge (Figure 3-8) and 

close the cartridge door. 

 

*Note: Before inserting the cartridge, click Park (Figure 3-6 B) to ensure the tray holder 

at the park position. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3-7 The guiding groove shall face front 

 

*Note: Cartridge can only be inserted in one orientation (Figure 3-7). 
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Figure 3-8 Push the cartridge to the bottom 

 

Then, click the Latch button on the Control Panel. The information of the cartridge will 

be displayed on the Cartridge Information section on the left side (Cartridge Number, 

Expiration Date, Runs Left…etc) and the cartridge picture will turn into color form after 

latched (Figure 3-9). The cartridge must pass the HV check and calibration process for 

its initial usage. For the details, please refer to Section 3.2. 

 

 

 

 

 

 

 

 

Figure 3-9 Before and After the cartridge latched 

 

*Note: Cartridge can not be latched without inserting the proper sample tray into the 

Qsep1-Lite. 
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3.1.2 Sequence Setting 

After latching cartridge, the cartridge-specific method will be showed on software 

interface (Figure 3-10). Follow the software instructions to click the method, sample 

position, and confirm the analysis information. Click Run to execute analysis after 

confirming. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3-10 cartridge-specific method 
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Method: each cartridge has one specific method. 

Click the method icon and click Next. 

 

 

 

 

 

 

 

 

 

 

Sample Selection:  

Click the well to select sample position and the well will turn red after selection. 

 

User can input sample information at Result Name Prefix blank. The software will 

automatically attach the sample information to result file name. 

 

DNA cartridge: select S1-S8 position (12-well sample tray) 

 

 

 

 

 

 

 

 

 

 

For DNA cartridge analysis, user must run a size marker mix every 24 hours. The 

software will lock the selection at Create Size Marker if there is no reference marker 

file that is created within 24 hours exist. If the size marker mix has been created in 24 

hours, user can select Use Last Created Reference(24 hr). The software will use the last 

created reference marker file to calculate the following sample runs. 

 

 

 

RNA cartridge: select M, S1-S4 position (8-well sample tray) 
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Confirmation: Confirm the analysis information  

Check the analysis information (cartridge type, analysis type, plate type, alignment 

marker, ladder) 

 

Separation Duration is the separation time during the execution. The separation time 

might be affected by the experimental condition such as temperature. Adjust the 

Separation Duration if needed (optional). The Separation duration is recommended to 

be 30 seconds longer than the time when the upper marker appears. 

 

Then, click Run to start the analysis 
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3.2 Cartridge Calibration 

In order to ensure the quality of the new cartridge, cartridge performance check (Figure 

3-11) is required before the initial usage. Follow the software instructions at main control 

panel to fulfill the cartridge performance check. 

 

 

 

 

 

Figure 3-11 Cartridge Performance Check 

 

The concept of the verification is to do the HV Check by checking if the current of the 

cartridge is stable under HV condition. The result will show passed if the current is stable. 

The function of Calibrate is to confirm the quality of the cartridge by executing the test 

of the alignment marker/quantitative marker and checking if the signal of the alignment 

marker/quantitative marker can be detected. 

 

Please prepare ≥ 20µL fresh alignment marker/quantitative marker in a 0.2 mL PCR tube 

(adding 10µL mineral oil to prevent evaporation) and place the marker at M position. 

Make sure the sample tray is placed on the tray holder. Insert the new cartridge and 

close the sample door.  

 

First, click Latch and follow the instructions to do the HV Check (Figure 3-12). If the 

cartridge working current (gray line) is above 2 µA and stable (Figure 3-13), the cartridge 

will pass the HV check. 

 

 

  

 

 

 

 

 

 

Figure 3-12 HV check 
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Figure 3-13 HV Check pass 

 

After passing HV check, follow the instructions to do the Calibrate (Figure 3-14). The 

Calibrate result needs to have two peaks (alignment marker) and the signal and noise 

value must over the threshold (green line) to pass Calibrate (Figure 3-15) 

 

 

 

 

 

 

 

 

Figure 3-14 Calibration 

 

 

 

 

 

 

 

 

Figure 3-15 Calibration succeeded 

 

The cartridge is ready to use after the “Calibration succeeded” message appears on the 

screen. If the “Failed” message appears, please check the alignment marker and buffer. 

If the calibration continuously fails for ten times, go to Help →Report to generate the 

error result file and send the file to your local distributor or visit BiOptic Inc. official 

website for technical support. https://www.bioptic.com.tw 

  

https://www.bioptic.com.tw/
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3.3 Purge Check Function 

Purge Check Function is used to see if the air comes out while purging. The system will 

recommend you do the purge check function before and after using Qsep1-Lite. 

  

 

 

 

Figure 3-16 Purge Function Check 

Make sure there is air coming out from the JET-NOZZLE. If there is no air coming out, it 

means the gel is clogged in the air tube. Then, you might need to clean the air tube at 

the cartridge door (please contact with your distributor for maintenance and repair 

service). If there is air coming out, please use your thumb to press the JET-NOZZLE and 

check whether the JET-NOZZLE can push to the end or not. If the JET-NOZZLE can be 

pushed to the end easily, it means the pressure is not enough. Please contact with your 

distributor for maintenance and repair service. 

 

 
Figure 3-17 Purge Check Function page1 
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Figure 3-18 Purge Check Function page2 

 

Figure 3-19 Purge Check Function page3 
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3.4 Lock Function 

Lock Function will make the tray holder move to the initial place.  

 

For Qsep1-Lite, this function can be used to close the sample door when sample tray 

taken out.  

 

Before moving Qsep1-Lite, click Lock to make the tray holder back to the initial place first. 

 

 

 

 

 

Figure 3-20 Lock Function 
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4. Q-Analyzer for Qsep1-Lite User Interface 

4.1 Main Window 

 

 

Figure 4-1 Main window 

 

  

A: Menu 

B: Function Bar  

C: Toolbar 

D: Operation Region 

E: Status Column 
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4.1.1 System Overview 

After launching Q-Analyzer for Qsep1-Lite, the Main Panel (Figure 4-1) will appear and 

provide serial function for operating Qsep1-Lite (sample analysis, results display, and 

result post-analysis). 

 

Menu: 

All available functions can be found in the Menu list. For details, please refer to 

Section 4.3 

Function Bar: 

There are four functions. You can select Instrument to the control panel and the 

detail of operation can be found in Section 4.4. If you need to display or analyze 

the data, please click the Results or Comparison (See Chapter 5). When the 

analysis is in progress, the collected data will display in the Real time.   

Toolbar: 

The Toolbar provides several icons relatively to the Function page you have 

selected. 

These icons are the most frequently accessed functions you may need. All the 

detail of the Toolbar relatively to the Functions will be described at Section 4.2 

Operation Region: 

Operation Region is the region that is used to operate or display the main 

window. After selecting the desired mode, the corresponding panel will display 

on the operation region. User can switch to the control panel by clicking 

Instrument in Function Bar or switch to the display panel by clicking Results or 

Comparison. When an analysis is in progress, the Real time mode will show the 

real-time signal in the operation region.  

Status Column: 

The information of the system status will be shown at the bottom of Main Panel 
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4.1.2 System Status Column 

The parameters shown at Status Column are as follow (Figure 4-1 E) 

 

Action: the proceeding action 

 

Position: the position of the sample tray 

 

Time Remaining: the remaining time to complete the processing action 

 

Pressure: shows whether the air pressure is applied properly 

Fail indicates there is lower than the system requirement 

If the pressure is on the low side of the system requirement, the color of pressure 

number will change from black to orange to remind you.  

 

Current: the current (μA) flow through the capillary 

 

HV On/Off: the status of High Voltage power supply  

 

Raw Count: the original signal 

 

Sample Door: the sample door is Opened or Closed 

 

Cart Door: the cartridge door is Opened or Closed 

 

Latch/Unlatch: shows whether the cartridge is placed and locked properly 

 

Runs Left: the remaining proceeding test 

 

Instrument ID: the serial number of the connected instrument 
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4.2 Function Bar and Toolbar 

In the Main window, there are four major functions of Q-Analyzer for Qsep1-Lite in 

Function Bar, which are Instrument, Results, Comparison, and Real time. User can 

select the desired function either to operate Qsep1-Lite or analyze the data. For easy 

access, the most frequently used functions are placed at the Toolbar. The detail 

information will be described in the following section. By default, the software will 

begin with the Instrument function. 

 

4.2.1 Instrument 

Instrument is the major control function to operate Qsep1-Lite. The usage of the control 

panel will be described in Section 4.4.  

Before connecting with Qsep1-Lite, the items on the Toolbar such as New project, Load 

project, Recent project, and Save project is enabled. User can create a new project or 

load the project, if necessary (Figure 4-2). The project can be used to differentiate 

various experiments. The results for different project will be saved in the corresponding 

“Result” directory. “Project name” is the name of the folder where the result files will 

be saved (i.e. “<workspace>\Result\<Project name>”). 

 

※Default <workspace> is C:\Users\ <user name>\ Q-Analyzer for Qsep1-Lite 

  

Figure 4-2 Instrument function before instrument connection 

After the instrument connected, the items on Toolbar such as Purge Check and Lock 

will be enabled. 
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Figure 4-3 Instrument function after connecting with instrument 

Purge Check:  

Purge Check will purge while the cartridge door is opened. User can ensure that the air 

is coming out while purging. (See Section 3.3) 

Lock:    

Lock will make the tray holder move to the initial place. For Qsep1-Lite, this function 

can be used to close the door when sample tray is taken out. 

 

Slide bar (Reduce and Extend) 

 

The remaining time of the proceeding action can be extended or shortened by dragging 

the slider at the bottom of the window. For instance, the software is going to running 

out the time of Separation & Detection, but the result is not completed yet; you can 

extend the remaining time by dragging the slide bar to the right (e.g. 50). The amount of 

the adjustment time will be shown on the button. Simply click the button to confirm the 

changes. Then the action of Separation & Detection will be 50 seconds extended 

immediately once the value reaches 0. 

 

*Note: Only the remaining time of the action which is in progress can be extended  

or shortened.  
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4.2.2 Results 

To display or analyze data, we provide the Results function. With the Results function, 

you can demonstrate the signal chart or get peak information from raw data of 

capillary electrophoresis.  

 

After the files are loaded in Q-Analyzer for Qsep1-Lite, the functions on Toolbar such 

as Calculate, Peak Calling, Parameters, Show Size/Legend, Show Size/Time, Invert 

GelView, Show Best/Ori. View, and Change Line Thickness are enabled (Figure 4-4). 

These functions allow user to deal with the data. For more details about editing the 

raw data, please refer to Section 5.1. 

 

 

Figure 4-4 Toolbar at Results tab 

 

Calculate:  

If the size of the result are wrong or empty, user can utilize the Calculate 

function on the Toolbar to get the calculated information (size (bp) and 

concentration for each peak). 

First, open the file you intend to calculate and make sure it is the selected 

window. 

On the Toolbar, select Calculate and click Load to load a suitable reference 

marker table for calculating the result.  

Please choose the reference marker file according to the condition of your 

experiments. Note that the files include four information which are  

1. Cartridge type (e.g. L1, L2…) 

2. Operation HV of the separation (e.g. 6, 8 KV) 

3. Size marker type (e.g. C109200, C109300…) 

4. Alignment marker type (e.g. 20-1k, 20-5k…) 

  For example: 

    

 

 

 

 

All the reference marker files corresponding to the pre-programmed methods 



46 
 

can be found at the default Load folder: “<workspace>\Reference” 

*Note: Default <workspace> is C:\Users\<username>\Q-Analyzer for Qsep1-Lite 

 

After confirming the reference data file, click OK, and all the peak information 

will be showed at the peak table. 

 

 

Apply to All Selected File(s) in List: do multiple result files calculation. 

Save File after Calculation: save the result file after the calculation completed. 

Please select this function if you want to have the calculated result every time 

you open the file. 

With Alignment: if you apply the alignment marker for analysis, select the 

checkbox. 

AM Mixture factor correction: select the checkbox of this function for proper 

calculation if the alignment marker is mixed with the sample. 

 

Peak Calling:  

Peak Calling function allows user to distinguish the target peaks. 

The software will follow the rules in the Peak Calling table and show the report 

at the Peak calling tab window. Report “+” when the peaks are found and show 

“-” when the peaks are not found. (See Section 5.4) 

 

Parameters:  

The system will generate the corresponding baseline and define the peaks 

automatically. If you are not satisfied with the results, you can modify them 

with Parameter functions. Make sure the selected result file window is the one 

you want to modify. Multiple files can be selected by clicking their checkboxes 
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before using the Parameter function. (See Parameter setting in Section 4.3.2) 

 

Show Size/Legend:  

Switch the index of the peak to display the bp value or legend in the chart. 

To display the size, the result data must be calculated. To display legend, the 

Peak Calling function data must be applied. 

 

Show Size/Time:  

Switch the x-axis between size (bp or nt) and time (minute). 

To display the size, the result data must be calculated. 

 

Invert GelView:  

Invert the color of white and black in Gel View (as showing below) 
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Show Best/Ori.View  

Show the best view of the signal pattern. 
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Change Line Thickness  

Switch the thickness of the peaks in the chart. 
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4.2.3 Comparison 

Using the Comparison function allows user to compare or analyze multiple results. 

With this function, you can put several signal charts together to compare the variance 

in different samples or conditions.  

Since the Comparison function is used to analyze multiple results in a chart, you need 

to open several results before performing the Comparison function. After opening 

several result files, click New folder and drag the result files to the folder window. 

Then, the results will be displayed on the folder window. The detail functions in the 

Folder such as demonstrating and comparing the results will be described at Section 

5.2. 

 

 

 

Use the Comparison function to compare different result files.  

Step 1. Open the files you want to compare.  

Step 2. Click New Folder in Toolbar to create a Folder. 

Step 3. Drag the files from the Filename panel and drop them into the Folder that 

you have created. 

 

  



51 
 

4.2.4 Real Time 

The Real Time function provides a real time display of the current and collected data 

which includes the current and RFU (amplitude of the capillary electrophoresis 

signal).  
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4.3 Menu 

4.3.1 File 

File functions are: 

 

New Project: Create a new test project. 

 

 

Figure 4-5 New project 

Project can be used to differentiate several experiment conditions. 

The test results will be saved in the corresponding “Result” directory. “Project 

name” is the name of the folder where the result files will be saved. 

 

Operating System Default Saving folder 

Windows 10 <workspace>\Result\<Project name> 

 

* Default <workspace> is C:\Users\ <user name>\ Q-Analyzer for Qsep1-Lite 

 

New Folder: Open a new folder to compare the results. 

 
Figure 4-6 New Folder 
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Folder in Q-Analyzer for Qsep1-Lite is used for comparing results. By clicking the tab at 

Figure 4-6 A, you may view the result in the signal (peak) or gel view. Figure 4-6 B 

displays the raw data of the selected point on the chart. Figure 4-6 C displays the 

imported files’ name. For more details, please refer to Section 5.2. The results are 

plotted as RFU (the Y axis) to TIME (the X axis) diagram. The baseline may vary 

between tests. 

 

The Signal Alignment function (Figure 4-6 D) might be utilized to align the 

baselines to the same level. After the signal alignment is achieved, you can 

compare the peaks from different results.  

 

The Time Alignment function (Figure 4-6 D) might be used to adjust the time 

variation. The Time Alignment function will align the Alignment Marker of each 

data. The default setting of system is assigning the first file in Figure 4-6 C as the 

base. You may right click on the file and select Main ladder to define your own 

base. The file name of the Main ladder will be presented in red.  

 

Signal Offset function (Figure 4-6 E) helps you separate the stacked data. You 

may reset the outcome by clicking Reset All.  

 

In the folder window, by right clicking in the signal tab, you can export the 

signal chart or gel view with or without the sample description and result name. 

 

 

Figure 4-7 Folder Export Chart 

 

Open File: Open the result files from each project.  

 

Open Folder: Open the folder files from each project.  

 

Save File: Save the modified result. Only the selected window will be saved. 
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Figure 4-8 Choose the window you want to save 

 

Save As: Save the modified result as another file name. 

 

Save All: Save all modified results. All the files in the operation panel will be saved. 

 

Save Folder: Save the created or modified Folder.  

 

Load Project: Load the saved project.  

 

Save Project: Save the current project.  

 

Recent Projects: List the latest projects you have opened for loading.  

 

Recent Files: List the latest result files you have opened for loading.  

 

Close: End and exit Q-Analyzer for Qsep1-Lite. 
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4.3.2 Edit 

Edit functions are: 

 

Sample file: Edit the information of each sample. (Figure 4-9) 

 

 

Figure 4-9 Sample file window 

 

Click Edit and the Sample loader window will pop-up. Select the sample 

position and enter the sample information, such as sample/patient name, ID, 

date, and description. Click OK to apply the changes or Clear to delete. Click 

Save or Save as to save the sample file. You may import the sample files you 

saved earlier with Load for inquiry or editing. An excel file can also be imported 

to edit multiple sample description. 
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Parameter: Change the parameters of the calculation settings. 

 

 
Figure 4-10 Parameter settings 

 

The system will generate the corresponding baseline and define the peaks 

automatically. If you are not satisfied with the results, the results can be 

modified by the Parameter function. Make sure the selected result file window 

is the one you want to modify.  

 

You may also select multiple files by selecting their checkboxes (Figure 4-11) 

before you use the Parameter function. 

 

 

Figure 4-11 Selecting multiple result files 

 

Baseline Factor affects the smoothness of baseline. The default Baseline Factor 

value is based on the chosen method. The bigger the value is, the smoother the 

baseline will be, and vice versa. 
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Peak Smoothing affects the smoothness of peak. The bigger the Peak 

Smoothing value is, the smoother the result will be. This function might be 

utilized to reduce the number of peaks. 

 

Peak Threshold changes criteria of defining the peak. The bigger the Peak 

Threshold value is, the stronger the signal is requested to be recognized as a 

peak. The peaks with low signal strength can be recognized by lowering the 

Peak Threshold value. Meanwhile, the noise may be recognized as signal peaks 

as well. 

 

S/N Peak Definition changes criteria of defining the peak. The bigger the Peak 

definition value is, the more data points of the ramping signal are required to 

be recognized as a peak. You may lower the Peak definition value to define 

peaks with less points of the ramping signal. Meanwhile, the noise may be 

recognized as signal peaks as well. 

 

Apply to All Selected File(s) in List will change the parameter of the file you 

selected in the list. Make sure to select this function if you want to do a 

multiple result file modification. 

 

Save File after New Parameter Applied will help you to save file automatically 

after applying parameter. 

 

Recalculate Result will help you to recalculate result and show the peak bp 

automatically after applying parameter. 

 

*Note: Click Default button to retrieve the original settings. 

 

Peak Calling Table: 

Peak Calling helps user to create the panels for quick scanning. To use peak 

calling, user needs to set up the Peak Calling Table which including the target 

peak information. You can customize your own peak calling table by adding a 

new row and assigning the Target, upper margin, lower margin, S/N, RFU, 

Legend and IC (Internal Control). 

For more details, please refer to Section 5.4. 
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4.3.3 Tool 

Tool functions are: 

Calculate: Use the reference marker table to do the base pairs calling and quantitative 

analysis of your result (Figure 4-12). 

 

 

Figure 4-12 Calculate workflow 

 

By clicking Load, the reference marker table will be imported. After loading, 

click OK to do the calculation, and the result file will show the corresponding 

values of bp and concentration. 

Apply to All Selected File(s) in List : do multiple result file calculation. 

 

Save File after Calculation: save the result file after the calculation is complete. 

Please select this function if you want to see the calculated result every time 

you open the file. 

 

With Alignment: if you apply the alignment marker for analysis, select the 

checkbox. 

 

AM Mixture Factor Correction: select the checkbox of this function for proper 

calculation if the alignment marker is mixed with the sample. 

 

Click “File→Save File” to save the calculated result. You may reset the 

calculated result of the value of bp and concentration to zero with the Reset 

function. 

 

Peak Calling: 
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Peak Calling helps user to create the panels for quick scanning. To use peak 

calling, you need to set up Peak Calling Table. (Edit → Peak Calling Table). For 

the detail, please refer to Section 5.4. 
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4.3.4 View 

View functions are:  

Chart Setting: Change the settings of the electropherogram. 

Chart Setting functions is used to set the color of line, Size/Legend, grid, 

background, data display, and whether to show the peak indicator.  

 

Gel View Setting: Change the settings of the gel image simulation.   

Choose to invert the gel image, display the peak line, or adjust the contrast of 

the gel image. 

 

In Figure 4-13, A is the original gel image in the system. After tuning the 

contrast, you may enhance those weak peaks as shown in B. C is the inverted 

gel image, and D is the inverted image after tuning the contrast of C. 

 

 
Figure 4-13 Gel Image 
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4.3.5 Window 

Window functions are:  

Cascade: Arrange the opened windows in the array format. 

 

Close All: Close all opened windows. 

 

All opened files will be listed below the Window. 

4.3.6 Setting 

Setting functions are: 

Change password: Change your password of the software key. 

 

Figure 4-14 Change password 

Please fill up the blank (Enter your old password, password, and password 

confirm). The password consists of 8 characters/numbers (case-sensitive) 

*Note: If you enter the wrong password over 15 times, your software key will 

be locked. 

 

Unblock PIN: If you enter the wrong password over 15 times, your software key will be 

locked. Please contact with BiOptic Inc. at the official website 

(www.bioptic.com.tw) or with your local BiOptic representatives to Unblock 

PIN. 

 

Figure 4-15 Unblock PIN  
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Preference:  

This page is used to configure the default setting of Q-Analyzer for Qsep1-Lite 

such as view method, Calibration time, motor setting, etc. We only suggest the 

professional person to modify these values. 

  

*Note: Some preference setting might change the default value of this 

instrument and affect the result of experiment. It is suggested to change this 

setting after you have a complete professional training from BiOptic Inc.. 

 

 

Figure 4-16 Preference setting 

 

4.3.7 Language 

Three different languages can be set as system language for Q-Analyzer for Qsep1-Lite 

software, including English (Default), Chinese (Simplified), Chinese (Traditional). After 

changing the setting, you need to relaunch Q-Analyzer for Qsep1-Lite. 
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4.3.8 Help 

Help functions are:  

Version:  

Display the version of your software and firmware. Technical Support file can 

also load from this window. 

You need to connect to Qsep1-Lite to get the information of the firmware. By 

clicking Technical Support, you can open a “bioptic” technical support file. 

 

 

Figure 4-17 Version window 

 

Help: Provide the information of Qsep1-Lite and Q-Analyzer for Qsep1-Lite.  

Help function can also open this operation manual. 

 

Report: Generate report files. 

Collect and save the system errors information into a file. When encountering 

troubles, you may use the Report function to generate the error report files and 

send them to BiOptic via service@bioptic.com.tw for technical support. 

 

Toolbox: Provide step-by-step trouble shooting process. 

Purge Function Check will purge while the cartridge door is opened. User can 

ensure that the air is coming out while purging. For more details, please refer to 

Section 3.3 

Motor Function Check is to check motor position and setting condition. Please 

follow the instructions accordingly. The software will remind user to open the 

sample door and the cartridge door, and then take out the cartridge from 

instrument. After clicking start, the motors will do all kinds of actions to move 

the tray holder, and user can observe motor status during each step. 

Computer Compatibility Check is to check the software setting environments, 

mailto:%20service@bioptic.com.tw
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including the hardware and software requirements. For more details, please 

refer to Section 1.3. 
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4.4 Control Panel 

When you launch Q-Analyzer for Qsep1-Lite, it will open the Control Panel 

automatically. There are three major functions in the Control Panel, which are Main, 

Direct Control, and Board Setting (Figure 4-18). Different level of access to those 

functions will be given to the user based on which software key the user has. With 

Basic software key, the user has access to Main and Direct Control tabs. Only the user 

with Advanced software key has access to Board Setting tab. 

 

The functions of those tabs are listed as follows: 

4.4.1 Main 

Main page is the major control to operate Qsep1-Lite. 

 

  
Figure 4-18 Main page 

 

Figure 4-19 A is for instrument control. Click Connect to establish the connection with 

Qsep1-Lite. 

 

After Qsep1-Lite is successfully connected, the picture of Qsep1-Lite on the Main Page 

will turn into color form. Connect button will become Disconnect for manual 

disconnection. Run and Stop buttons are used to start or end a test. There are three 

different forms of the Run button during a test:  
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Run: start the test 

Pause: pause the running test 

Continue: resume the unfinished test. 

 

Open Sample Door opens the sample door and move the tray holder out. 

  

Park moves the tray holder to Park position. 

 

Latch and Unlatch are used to connect or disconnect the cartridge(s) with the 

instrument. Before executing a test, you must Latch the inserted cartridge. The 

cartridge information will be displayed on Figure 4-18 B, and the picture will turn into 

color. Click Unlatch and wait for few seconds before removing the cartridge.  

 

 
 

Figure 4-18 C shows User ID and Project Directory. After latching, the cartridge 

information such as Cartridge Number, Expiration Date, Runs Left, Last Run Date and 

Description will be displayed. 

 

Follow the instructions on Figure 4-18 E to select cartridge specific method, sample 

position and perform an analysis run (see Section 3.1.2).  

 

The remaining time of the proceeding action might be extended or shortened by 

dragging the slide bar in Figure 4-18 F. For instance, the time of Separation & Detection 

is running out, but the result has not completed yet; you may extend the remaining 

time by dragging the slide bar to the right (e.g. 40). The amount of the adjustment time 

will be shown on the button. Click the button to confirm the change. Then, the action 

of Separation & Detection will have 40 seconds extended immediately.  
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4.4.2 Direct Control 

All the actions of the analytic method can be executed manually and independently 

under Direct Control. You can also move the tray holder to the designated position.  

 

Figure 4-19 Direct Control page 

Basic version 

 

Purge: set the time used for purging.  

HV Purge: set the time and voltage used for purging.  

 

Advanced version 

 

Motor Initialize: initializes the motor position.  

Position: can move the ideal well below the cartridge tip. 

Purge: set the time used for purging.  

HV Purge: set the time and voltage used for purging. 

Action: You may select Sample Injection, Marker Injection, and Separation & 

Detection and assign the duration and voltage. 

 

*Note: Every execution of Separation & Detection will deduct the available runs of the 

cartridge. 
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4.4.3 Board Setting (Advanced Only) 

Board Setting provides the information of the Instrument ID, Raw Count/Current, 

PMT Voltage, Sample Rate, Light, and Data Collect.  

 

The Sampling Rate function can be used to change the frequency of collecting the raw 

data. The Data Collect function can be used to collect the raw data for an assigned 

duration. During data collection, the raw data shows at the Raw Count / Current table. 

After executing Data Collect function, the average, standard deviation, maximum, and 

the minimum of the raw counts and current show at the table below. 

 

  

 

Figure 4-20 Board setting page 

 

  



69 
 

5. Post-Analysis 

5.1 Result for Data Display 

Using the Result function, you can analyze the data from Q-Analyzer for Qsep1-Lite. The 

Result function can help you to demonstrate the chart or to edit the bp value from the 

raw data of the capillary electrophoresis.  

 

The latest result will be shown in the Main Panel after each test finished, and the 

previous result window will be closed automatically. 

 

Open the result file by clicking “Open File” icon at Result tab (Figure 5-1) or from “File” 

in menu (Figure 5-2). The browser helps you to select multiple files and display the 

chart of the collected data. According to the default settings, the result file is saved as 

“.lte ” file, and the result directory of Q-Analyzer™ is stored at: 

<workspace>\Result\<Project name> 

* Default <workspace> is C:\Users\<user name>\Q-Analyzer for Qsep1-Lite 

 

Figure 5-1 Open File icon 
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Figure 5-2 Open File from menu 

 

If you open lots of results, the order of files can be changed by clicked the right button 

in the “Filename” (The following pictures) and user can arrange the files by “Sample, 

Runs, Test Date, Cartridge”. Click the first row (red arrow) can change the order. 
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Figure 5-3 Result Display 

 

 

There are several tabs in the Result file, which are Signal, Current, Information, HV 

Purge, Sample injection, and Peak calling (Figure 5-3). On the right side, there is a peak 

table that including Time, RFU, Peak Area, bp/nt, Concentration (ng/ul), nmol/L, Peak 

Start (sec), Peak End (sec), S/N, FWHM (sec) and Area (%) (Figure 5-3 B). The value of 

bp and concentration will only be displayed after the calculation is performed. 

 

 

Figure 5-4 functions in region B 
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If you right click in region B, several functions are available: Export report function, 

Lower/ Upper marker adjustment, Delete/ Merge peak, and others (Figure 5.4). 

Exported function including Export Report, Export Chart and Export Raw Data . Export 

raw data will save the data as a “.csv” files.  

 

Set as Lower/Upper Marker can assign the selected peak to be the lower upper or 

upper marker. Make sure to set the correct lower and upper marker in order to 

calculate bps and concentration. Please note if the lower or upper marker didn’t assign 

correct, then the size and concentration result will not be accurate.  

Delete Peak(s) is to remove unnecessary peaks at peak table. Merge peaks function is 

to merge two or more peaks become one peak. It can help you combine the minor 

peaks with the major ones. Select those peaks you would like to combine, and right 

click the selections and select Merge peaks. It will add up the peak area of the selected 

peaks and further define the peak migration time of this merged peak area from the 

major peak. 

*Note: Make sure you execute the Calculate function after merging peaks to get more 

accurate results. 

 

Remove Calculated Info to remove the original calculated information. Update 

Cartridge Factor to renew the following running results after assigning the correct 

lower marker and upper marker.  

  

  

 

Figure 5-4 shows the result of the electropherogram. The green arrows indicate the 

first and the last peak of the result. The red arrow indicates the selected peak in the 

table B. Figure 5-3 D shows the gel view image of the result. Figure 5-3 E displays the 

raw data of the spot you selected. 
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5.1.1 Calculation  

If you find the size values of the result are wrong or empty, you can utilize the Calculate 

function on the Toolbar to get the respective value of bp and concentration for each 

peak in the result.  

 

To calculate the results, please follow the steps below: 

 

Step 1. Open the file(s) you intend to calculate. The result files also can be calculated 

by batch. Tick the checkbox from left side list if the result files are more than one, and 

make sure those results were analyzed by same type of cartridge. 

 

 

Step 2. Check lower marker and upper marker are all assigned correctly for all the 

results. If the lower marker or upper marker didn’t identify correctly, please reassign to 

correct peak. 

 

Step 3. Click Calculate button on the Toolbar and click Load to select a proper 

reference marker table for calculating your result.  
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Step 4. You can select the build-in reference marker from same type of cartridge or use 

your own reference marker to calculate it. 

 

 

 

After confirming the reference data file, click OK, and then the value of bp and 

concentration will be shown in the columns. After the qualitative calculation analysis is 

completed, click Save File to save the file. 

 

How to select proper reference marker? 

 
Build-in reference marker: the marker is created by BiOptic, and it is saved in the 

software. 

All the build-in reference marker files corresponding to the pre-program methods can 

be found at the default Load Folder: “<workspace>\Reference” 

* Default workspace is C:\Users\<username>\Q-Analyzer for Qsep1-Lite 

 

Note that the file name of reference marker in “Reference” fold include four 

information which are  

1. Cartridge type (e.g. L1, L2, LQ1…)  

2. Operation voltage of the separation (e.g. 6, 8KV)  

3. Size marker type (e.g. C109200, C109300…)  

4. Alignment marker type (e.g. 20-1k, 20-5k…) 

For example: 
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User’s own reference marker: all the create size marker results will be stored in the 

result folder  

 

 

Please note the reference marker should be created by same type of cartridge or it will 

affect the accuracy. For example, if the result was tested by L1 cartridge, the reference 

marker will need to run by L1 cartridge instead of L2 or LQ1 cartridge because using 

different type of cartridge, the gel matrix, method condition and the size of alignment 

marker are all different, the marker and the result are incomparable.  

 

If you need high accurate bp size resolute, please use create size marker function to 

run a size maker and to calculate the following samples. If the samples have been run, 

but without size marker result, you can use the reference marker which tested by the 

same cartridge to calculate those result. the results will more reliable than using build -

in reference marker. 

 

Other functions on “Calculate” window: 

 

 

Apply to All Selected File(s) in List: if you want to do multiple result files calculation. 

Save File after Calculation: save the result file after the calculation is complete. Please 

select this function if you want to see the calculated result every time you open the 

file. 

With Alignment: if you apply the alignment marker for analysis. 
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Please choose the reference marker file according to your condition. 

We prepare a complete set of the reference marker files corresponding to all the pre-

program methods. 
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5.2 Comparison 

Use Comparison to compare the different result files.  

Step 1. Open the files you want to compare in Results.  

Step 2. Click New Folder in Toolbar to create a Folder. 

Step 3. Drag the files from the Filename panel and drop them into the Folder that you 

created as shown below:  

 
 

Show the electropherogram or gel image by selecting the tab in Figure 5-5 A. Figure 5-5 

B displays the corresponding information of the spot you have selected. When you click 

a file name in C, the corresponding data in the chart will be highlighted and you also 

can change the color of the line by clicking the small color block in the first column. 
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Figure 5-5 Data Comparison in Folder Chart 

 

Due to variety of the experiment conditions, you may need to normalize your test 

results by utilizing the Alignment functions (Figure 5-5 D) to align your data.  

 

Time Alignment uses the Alignment Marker of each file as the mark to scale the data 

to be aligned with those of the first file (Figure 5-6). 

 

Signal Alignment adjusts the baseline of each file at the same height (RFU) with the 

baseline of the first file (Figure 5-7). 

 

Signal Offset (Figure 5-4 E) helps you to separate the stacked data. Simply set the value 

in Signal Offset and click Apply All, shown in Figure 5-8 and Figure 5-9. You may 

retrieve the original result with the Reset All function. 
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Figure 5-6 Comparison of Result Data with Two Different Baselines 

 

 
Figure 5-7 Use Signal Alignment for Baselines Adjustment 
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Figure 5-8 Three Stacked Result Data 

 

 
Figure 5-9 Use Signal Offset for Distance Modification among Each Result Data 
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Figure 5-10 Use Time Alignment for Scaling the Two Peaks as the Same Time Line 
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Figure 5-11 The Gel View Based on Time Alignment for Scaling the Two Peaks as the Same Line 

 

 

 

Figure 5-11 Use ”Main Panel→View→Gel view setting→Invert” for Inverting the Gel View 
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Figure 5-12 Use “Main Panel→View→Gel view setting→Contrast” for Contrast Adjustment of Gel View 

 

 
Figure 5-13 The Base Pairs of Peaks Appearance when You Move Cursor on Each Line 
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5.2.1 Export the Report of Compare Result 

To save the results of data comparison, user can follow the steps below to export the 

report of the Folder. After entering the result files into New folder and completing the 

comparison, right click and select Export report (Figure 5-14). Q-Analyzer for Qsep1-

Lite™ will automatically generate the report file and select the format 

(Preview/PDF/DOC/XLS), then enter the file name and save the file to the designated 

folder (Figure 5-15). 

User can save the comparison results by using the function Save Folder, too. 

You can find the Save Folder option under File at the Main Frame. (Figure 5-16) 

 

 

 

Figure 5-14 Right click and select Export report 
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Figure 5-15 Select the file format, enter the file name, and save the file to the designated folder 

 

Figure 5-16 Function of Save Folder 
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5.3 Total RNA Quality Analysis 

To understand the quality of RNA sample, user can refer to the RNA quality number 

reference and self-score the RNA result. Obtain the RNA Quality Number (RQN) by 

conducting the steps below. 

The RNA tab in result file will be enabled when running sample by LR1 cartridge with 

RNA method (Figure 5-17). 

 

  

Figure 5-17 RNA method 

 

Step 1. Select to RNA tab (Figure 5-18).  

  

Figure 5-18 RNA Sample Result 
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Step 2. Click on the RQN drop-down list. Take the provided example RNA result as 

reference to do RQN self-scoring (Figure 5-19). 

  

 

Figure 5-19 RNA Quality Number self-scoring 

 

Step 3. Save file after self-scoring RQN to keep the RQN information. 

 

 
 

Step 4. Click the right button in the gray region to export the report 

 

*There will be a label on the report shows that the RQN is user self-scoring  
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5.4 Peak Calling Function for Clinical Testing 

Peak Calling function allows user to quickly distinguish the target peaks. 

Q-Analyzer for Qsep1-Lite will follow the rules in the Peak Calling table and report “+” 

when the peaks are found and show “-“ when the peaks are not found. 

 

To use the Peak Calling function, do the following steps: 

Step 1. Click Edit → Peak Calling Table to load the Peak Calling table (Figure 5-20 A). 

Step 2. Click the right button and select Add Row to add a new panel (Figure 5-20 B). 

Step 3. Set up the new panel. Enter the criteria in the columns for the peak (Figure 5-20 

C) and save as a new file (Figure 5-20 D) to the default folder.   

• Target: The center value of the peak. 

• Upper/Lower Margin (size): The upper/lower margin of the peak target 

that will be assigned as the Legend. 

• SN: Configure the criterion of signal and noise ratio of the peak (optional). 

• RFU: Configure the criterion of signal amplitude of the peak (optional). 

• Legend: Enter the Legend name. 

 

 

Figure 5-20 Peak Calling Table  
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Step4. Return to the page of your result files, calculate the fragment size and select the 

Peak calling tab. (Alternatively, you can select Peak Calling from the Toolbar or 

Tool→Peak Calling. Figure 5-21 A-B).  

Step5. Browse the desired file and load your Peak Calling Table (Figure 5-21 C). 

Step6. Click Signal tab and return to the chart, the software will automatically scan the 

peak signal. Click Show Size/Legend button on the Toolbar, the legend of target 

peak will be displayed on the window. You can also click the right button to 

export the report. (Figure 5-22) 

 

*Note: Incorrect fragment size might affect the result of Peak Calling. Please 

ensure your experiment is properly calibrated and the peak has the correct bp 

value.  

 

 
Figure 5-21 Fragment Size Calculation and Peak Calling Selection 
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Figure 5-22 Loading Panel and Exporting the Report 
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Appendix A-Troubleshooting 

 Please exclude these issues first … 

• Insert the pin into the small hole of cartridge cap and press it all the way in.  

• Follow the cartridge user guide to prepare sample and marker. 

• Size marker mix should be placed at the correct position (M position) 

• Instrument (include air pump) power need to be turned on. Ethernet cable and 

air tube should be connected well. 

• Q-Analyzer for Qsep1-Lite should be updated to the latest version. 

 

1. Unpacking, packing process, and installation 

Q1：How to unpack the cargo and what should we notice when moving the 

instrument? 

A： 

• About the unpacking process, please follow the unpacking guide we provided 

in the box or download from the website.  

• Please keep the box and cushioning materials. Because you will need all these 

pieces of stuff when you are going to transport the instrument. 

 

Q2：What are the minimum computer requirements and recommendations? 

A： 

• Please refer to Section 1.2 System Installation. 

  Minimum Recommended 

OS Windows 10 32 bit Windows 10 64 bit 

CPU Intel Core i5 Intel Core i7 

RAM 8G RAM 16G RAM 

HDD 500 GB 1 TB 

PORT RJ45 x 1 RJ45 x 2 

Screen Resolution 1280 x 800 1920 x 1080 

• Q-Analyzer for Qsep1-Lite use about 30-40 MB of RAM 

 

Q3：What is the size of the result file? 

A：Each file is 120 KB; 1 GB can store 8,333 files; 8 GB can store 66,664 results. 

 



92 
 

Q4：Do we need to install the software first or connect the cable first? 

A： 

*Follow the Quick start of instrument installation and software installation.  

Step1. Install the instrument & Pump 

- Connect the Instrument with pump 

* The pump might need to be placed on the floor 

Step2. Install Q-Analyzer for Qsep1-Lite in PC 

- the set-up program is stored in the software key with the latest version. 

Please insert the software key to install Q-Analyzer for Qsep1-Lite. 

Step3. Connect the Ethernet cable with instrument & PC and open Q-Analyzer for 

Qsep1-Lite 

- to avoid restarting the PC again 

 

Q5：Can power adaptors be used alternately? 

A：No. 

Different devices need different voltage (power) to trigger. Not enough power may 

influence the normal function of the instrument. Please follow the label on the 

adaptor wire. 

 

 

2. Instrument not working or working abnormally 

2.1 Before use 

Q1：What should we do when PC cannot connect with Qsep1-Lite? 

A： 

• Make sure Qsep1-Lite is turned on and has connected with computer by 

ethernet cable. If using RJ45 to USB adaptor for Ethernet cable connection, 

make sure the computer has installed the driver for RJ45 to USB. 

 

• Check the computer settings 

→ IP setting: enable DHCP 
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Go to windows Settings> Network & Internet.  

Select Ethernet and find the Ethernet network you're connected to. 

Under IP assignment, select Edit 

Under IP settings, select Automatic (DHCP) 

→ Firewall setting: allow Q-Analyzer for Qsep1-Lite pass through the firewall 

or turn off the firewall 

 

• Run the Q-Analyzer for Qsep1-Lite as administrator 

Right click on the Q-Analyzer for Qsep1-Lite icon. Select Run as administrator to run the program. 

Q2：What does the light of Qairbox mean? 

A： 

 

2.2 During use 

Q3：If the sample tray holder can’t move smoothly, how should we do? 

A： 

Please refer to section 4.3.8 Help: Motor Function Check and use motor function 

check to check each action and report to us.  

Step1. To the Main Page>> Help>> Motor Function Check 
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Step2. Please follow the instructions in the window popping up. 
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※If the motor function check is failed, copy the information in the window and save it as a .txt file. 

Provide the file and report to local distributor or contact with BiOptic. 

 

 

Q4：The Qairbox works frequently, over 3 times/min 

A： 

• Check the air leaking of the system airway. Make sure the air tube is well 

connected to Qairbox and Qsep1-Lite. 

 

 

• Replace the filter. There are three kinds of filters can be used. The right one is 

the strongest, which can be used longer than the other two. And the middle 

white one is stronger than the left blue one.  
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Q5：Jet error window pop-out. 

A： 

Please send all the files mentioned in the warning window back to the BiOptic. Before 

you click “OK” in the warning window, please find and copy the file it mentioned first. 

After getting the file, click “OK” and restart the software. 

 

 
 

3. Cartridge issues 

3.1 Before use 

Q1：HV check failed or Calibration failed. 

A： 

HV check  

• Make sure follow the “Cartridge Unpacking Guide” to unpack the new cartridge 

• New cartridge has an inner cap to prevent gel stock in the cartridge cap, please 

use a needle to punch a small hole at the inner cap. 

 

 

• During the HV check, to check the current is stable or not in the final 60 

seconds (2 µA). After HV check, if the current is still unstable, please repeat this 

step 2-3 times. 

Push the pin down to the end 

then move up and down at least 

2-3 times 



97 
 

 

• Stable Current:  

If the current is stable, then please change to fresh alignment marker, and the 

volume of alignment marker should be above 20 µl. Then you can do the 

following steps. 

• Unstable Current:  

Please use purge function at Direct Control to purge this new cartridge for 15-

30 mins and soak the cartridge tip in hot water if needed. 

If the cartridge still can’t pass the calibration, please contact and send the 

report (zip file) to local distributor or BiOptic. 

 

Calibration: Use alignment marker that attached in each type of cartridge kit to do 

calibration. 

The criteria: 

• DNA cartridge passing condition: there are two peaks (more than two or less 

than two will also failed) and the S/N value is over 60.  

• RNA cartridge passing condition: there is only one peak and the S/N value is 

over 60. 

• Peak time must be within the specified range, cannot be shift too far. 

 

If the calibration failed, user can do it again, and it will extend 10s of the HV purge 

(10n, n= calibration number) and 30s of separation in next calibration. 

 

※The cartridge will be locked after 10 times failed. 

 

Q2：What’s wrong with the pop-out error window when latching cartridge? 

A： 

Error 

Code 

 
Checkpoint Preliminary treatment 

01 RFID module is out of 

order 

RFID Reader • Restart the instrument 

• Re-latch cartridge 
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02 Can’t find the Tag RFID Reader or 

RFID tag 

• Re-latch 

• Use the other cartridge to 

confirm 

• Restart the instrument 

05 Incorrect format of 

RFID Tag 

RFID tag • Re-latch 

06 Error from RFID 

decoding      

RFID tag • Re-latch 

 
※For error 05 and error 06, if the cartridge had successfully latched before, please 

use the same computer to re-latch the cartridge for several times. The system will 

try to use the previous data to fix the error. 

 

3.2 During use 

Q3：How to check if the cartridge is clogged or not and how to rescue the dry out 

cartridge? 

A： 

• Using the purge station (C104002-100) to purge the 

cartridge and see whether the gel drop forms. If not, 

soak the cartridge tip in the buffer tray or beaker with 

hot water for 10-15 mins and then purge again. It will 

be even better to soak and purge at the same time 

 

 

※ Recommended settings for purge station 

. 
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Q4：What if the cartridge has expired, but still has runs left? 

A： 

• We are not solving the issues from expired cartridge. 

• About the expired cartridge, user can use them to do the “pre-analysis” or 

use to test the sample with unknown buffer condition, because sometimes 

unknown buffer may damage the capillary. 

 

Q5：Anything needs to notice during insert or take out the cartridge? 

A： 

• Please stand up and insert the cartridge vertically into the instrument 

• Do NOT hit the tip of the cartridge. 

 

• When finishing the analysis, click “unlatch” and wait for about 5 seconds before 

you open the cartridge door.  

• If you do not click unlatch before opening the cartridge door, the system will 

pop up a warning window. Taking out the cartridge without unlatch might cause 

anode pin damage. 

 
 

3.3 Storage 

Q7：How to store the cartridge kit? 

A： 

• For the details, please refer to the document of “Storage Condition of 

BiOptic’s Products”. 
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• Cartridge cannot be stored or placed overnight in the Qsep1-Lite. Please put 

the cartridge in the cartridge shell and avoid the light after use. 

• Place the cartridge back to the package, user might need to gently insert the 

cartridge tip into the protection gel in the cartridge shell. 

 

 

 

 

 

 

 

 

 

 

 

 

4. Questions of operation 

Q1：The sample consumption (per run)? 

A： 

• For different cartridges, all the sample consumption is < 0.1 µl per run. 

 

Q2：What if we use the wrong buffer to do separation? 

A： 

• Using water or dilution buffer to do the separation, the peaks pattern 

becomes abnormal and the current is unstable. Make sure you put separation 

buffer at the “S” well on the sample tray. 
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Q3：Will dye or organic solvent influence cartridge? How to pretreat the sample? 

A：  

If the sample contains dye (e.g. PCR product with loading dye), the dye might 

affect the capillary. If there is dye or organic solvent in the sample, please try the 

sample dilution or even cleanup will be better. 

 
 

Q4：What is the difference between Basic and Advance software key? 

A： 

• More function 

 

• Board Setting. (Advance key only) 
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Q5：What is the difference between Q-Analyzer, Q-Editor, and Q-viewer? 

A： 

• Please refer to software operation manual section 2.2 Software Mode.  
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5. Unexpected results 

Q1：Get unexpected result when running size marker or sample. What should 

we do? 

A： 

When getting unexpected results, check the current at each analysis step. Find the 

current information at Current/HV Purge/Sample Injection tab in result file. 

 

 

• Unstable HV purge current:  

1. The cartridge might be clogged. Purge the cartridge for a while by using purge 

function in Direct Control tab. The details of purge function, please refer to 

section 4.4.2 Direct Control. 

 

• Unstable sample injection current:  

1. The cartridge might inject air. Make sure there is no air bubble in the sample. 

2. Check the sample volume. 0.1 ml tube should add 10 ul and 0.2 ml tube 

should add 20 ul. 

3. Check the sample position settings. Make sure you select the position that 

sample allocated. 

 

• Current (Separation current): 

1. The cartridge might be clogged. Purge the cartridge for a while by using purge 

function in Direct Control tab. 

2. Unstable HV purge current or sample injection current will affect the 

separation current. Purge for a while to recover the cartridge before starting 

analysis. 
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※Purge function 

 

 

• After purging cartridge for a while, user can run a size marker mix alone to check if 

the cartridge is performed well. 

1. Go to Settings>Preference>Sequence 

 

 

 

2. Select “Troubleshooting: Only Run Size Marker”. 
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3. After setting, user can complete the analysis procedure to run a size marker 

without selecting sample position. 

 

4. Open the size marker result file. Check the peak pattern and HV purge/Sample 

injection/Current(separation current) current. 

 

 
 

※If the current is still unstable, purge the cartridge again. Then, repeat the steps to 

run a size marker mix again. 

 

Q2：What to do if alignment marker and samples are migrating too slowly and 

the upper alignment marker does not appear on the result? 

A： 
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Step1. Check the alignment marker is fresh or not. 

Step2. Check the current in each step is okay or not. 

 

• If the current is unstable during one of the steps, please refer to 5-Q1 to 

resolve the issue. 

• If the current is stable, it might be the environmental issue, such as 

temperature. 

◼ 10 ℃: Speed up the separation current (1.2x) 

◼ 10-19 ℃: Speed up the separation current (1.1x) 

◼ 20-29 ℃: Room temperature 

◼ 30 ℃+: Slow down the separation current (x0.9) 

 

 

Q3：Identified wrong alignment marker or size marker 

A： 

Alignment marker is to calibrate of migration time for each run. The size marker file 

acts as a reference for software to calculate the sample size. Identifying alignment 

marker and size marker properly is important. If the software identified wrong 

alignment marker or size marker, the sizing result will be affected. 

 

When system identify wrong alignment marker or size marker, follow the instructions 

below. 

• Re-assign lower/upper marker and update the cartridge factor 

If the system recognizes wrong lower/upper marker in the first tun, re-assign the 
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alignment in first and update the cartridge factor. The following result will use the 

updated factor to assign the alignment marker. 

 

Step 1. Find the lower/upper marker peak. Right click on the peak and select Set 

as Lower Marker or Set as Upper Marker 

 

 

Step 2. Recalculate and save the result 

 

 

Step 3. When sequence is still running, user can select “Yes” to update the 

cartridge factor for the following sample run. 
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• Re-assign size marker peak and update ladder result 

Step1. Load a built-in reference marker and check if the software identifies wrong 

size marker peak. Find the built-in size marker at C:\Users\XXX\Q-Analyzer for 

Qsep1-Lite\Reference. 

 

 

 

Step2. Right click on the peak and disable/assign as size marker peak 

 

Disable for Ladder Peak Candidate: If software assigns a peak that is not 

including in size marker, choose Disable for Ladder Peak Candidate to ignore the 

peak. 

Assign as Specific Reference Peak: If the software identifies size marker with 

wrong size, use Assign as Specific Reference Peak to assign the size marker peak 

with correct size. 
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Step3. Right click at peak table and select Re-Assign Ladder Result 

 

 

Step4. Right click on peak table and select Update Ladder Result. 

 

When re-assigning the size marker file during sequence, the software will ask if 

user would like to update the ladder information for following sample run. Check 

the Update for Following Sequences, Recalculate, and Save checkbox to use 

updating size marker for calculation  
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When re-assigning the size marker file after analysis, user can Recalculate and 

Save the updated reference file. After recalculating the size marker file, go to 

information tab of size marker file, right click on the Reference Marker table. 

Select Export Reference Marker Data to export the reference marker file for 

result file calculation. 

 

 

To calculate the result file, please refer to section 5.1.1 Calculation 

 

Q4：The calculated size is wrong 

A： 

• Environment may influence the migration time, so use the “Create Size Marker” 

function. The software will use the size marker you run to calculate the 

following sample size. 
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• The specifications of all the same types of instrument on the market are also 

about 10% deviation. 

• The platform we provide for DNA analysis is native condition, so the 

conformation of double strand DNA may also affect the migration. 

 

 

Q5：Is the concentration display in result table reliable? 

A： 

• Use quantitative cartridge kit to get more accurate concentration results 
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6. Specific application issues (RNA) 

6.1 LR1 RNA cartridge 

Q1：When running RNA samples, are there any special things to consider? 

A： 

• Clean up everything to avoid the contamination of RNase. 

• Use tissue with ethanol to wipe the cartridge tip 

• The separation buffer and dilution buffer we provided are 10x stock and need 

to be diluted to 1x via DEPC-water. 

• Sample Treatment: heat the RNA sample at 95/ 70℃ for 2-5 minutes, and 

place on ice immediately until analysis. 

• Mix the RNA sample with 5X Lower Marker before analysis 

 

Q2：How to self-scoring RQN value for RNA sample 

A： 

• There is a reference table for RNA quality number (RQN). User can refer to 

the table to assign the RQN value 

 

• According to the experimental design, you should create your own criteria for 

your RNA samples. 
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7. Maintenance 

Q1：How often should I change the buffer at S/P/C well? 

A： 

For Qsep1-Lite 

• The buffer at S/P/C well need to be changed every 20 runs  

• System will also pop out a window to remind user to change the buffer. 

 

Q2：What happens if I didn’t change the filter for a long time? 

A： 

• There may be insignificant air leaks. 

• Not enough pressure may reduce the replacement efficiency of gel in the 

cartridge. Old gel may influence the current and even the analysis result may 

have some unpredictable affect. 

 

Q3：How to clean the instrument regularly?  

A： 

• The outside of Qsep1-Lite could wipe with dry cloth. No detergent or ethanol, it 

might destroy the color. 

 

8. Others 

Q1：Should we turn off the instrument and air pump every day?  

A： 

No need. 

For the Pump: 

User might need to remove the condensate in the water cup before running the 

sample.  

 
 



114 
 

Q2：How should we do before discard the cartridge?  

A： 

Step1. Wear the gloves. 

Step2. Bend the cartridge tip to prevent the tip jab to someone. 

Step3. Open the cap and remove the inner cap. 

Step4. Pour the gel into the container for chemical waste liquid. 

Step5. Throw the cartridge into the trash can. 

 

Report to BiOptic 

• Fill the “Troubleshooting Form” 

• Clearly identify the time when issue occurs. 

• Sample information, include sample type, buffer condition, approximate sample 

size 

• Describe your problem in detail, including words, figures, video, result files and 

report (.rar). To export the system report, follow the instruction below. 

1. Go to Help>Report 

 

2. Save the report zip file 


